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1 Overview 
 
Welcome to the BS Recording Search  application. 
 
Within the SBS-1 Basestation application it is possible to make a recording of all 
those aircraft that are being displayed on the Basestation ‘radar’ screen. 
 
Use the SBS-1 Basestation - Start Recording option to start a recording. 
The data recorded is saved in a recording file and uses a file name suffix of 
‘.bst ’. 
  
This BS Recording Search  application enables you to extract certain records 
out of an existing recording file and create a new smaller more manageable 
recording file containing only the required records. [Basestation prevents a user 
from accessing the recording file currently being recorded] 
 
After you have run this program, the new file can then be played back using the 
standard SBS-1 Basestation – Play Previous Recording option. 
 
 
BS Recording Search  
 

·  enables you to extract all the records in a recording file that match a 
selected ModeS code e.g. 400ABC. 

 
·  enables you to extract all the records in a recording file that match a 

selected Callsign [wild cards are allowed] e.g. BAW12%. 
 
·  enables you to extract all records in a recording file that fall within a 

selected date and time range e.g. 2008 01 28  12:34  to  2008 01 28  
13:45 

 
For each of the options above it is then possible to ‘speed up’ the output so that 
when you play it back it appears at 2, 5 or 10 times faster than the original speed. 
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2 Installing the Application 
 
If you already have a copy of BS Recording Search i nstalled on the PC, 
uninstall the existing version by using the standar d Windows Add or 
Remove Programs.  
 
If you are not over-confident about unzipping files and installing applications 
please follow the more detailed instructions in Section 11. Hopefully this will 
assist you. 
 
Download the zip file and place it in a suitable folder. Extract the contents. 
 
There is a User Guide ‘BS_Recording_Search.pdf’ in the zip file. Save this to 
your PC. Please read it, especially the section regarding Playback. 
 
Execute the setup.exe to install the application. 
If you get a “Application Install – Security Warning” click on the ‘Install’ command. 
 
BS Recording Search needs Microsoft .NET Framework 3.5. If this is not already 
installed on your PC, it should automatically download and install from the 
Microsoft site as part of the overall installation. If you have problems see Section 
12 Installing Microsoft .NET Framework 3.5 
 

3 Removing the Application 
 
If you wish to uninstall BS Recording Search, use the standard Windows Add or 
Remove Programs. 
 

4 Launching the Application 
 
You can launch the application by selecting 
Start  

All Programs 
BS Recording Search 

BS Recording Search 
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5 Creating a Shortcut 
 
You can create a shortcut on the desktop to execute BS Recording Search by 
selecting 
    
Start  

All Programs 
BS Recording Search 

right click  on the next BS Recording Search 
select Send To > 

  Desktop 
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6 BS Recording Search Window Options 
 
The screen shot below shows how the BS Recording Search window looks when 
first started. 
 

 
 
The current version number should appear on the top of the window e.g. “BS 
Recording Search v1.0” 
 
Each of the commands, options and input requirements are detailed below. 
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6.1 File Management 
 

 

6.1.1 Select Input File 
 
Execute the ‘Select Input File’ command. 
The standard Microsoft ‘Open File’ dialog window is displayed. Navigate to the 
required existing recording and select with the OK command. The selected file 
name is displayed. 
 
The folder (directory) of the selected file is saved when you exit BS Recording 
Search. When you restart BS Recording Search the saved folder will be used as 
the initial folder in the file dialog window. 
 

6.1.2 Select Output Folder 
 
Execute the ‘Select Output Folder’ command. 
The standard Microsoft ‘Browse For Folder’ dialog window is displayed. Navigate 
to the required folder where you want the new output recording file to be saved 
and select with the OK command. The selected folder name is displayed. 
 
The folder (directory) is saved when you exit BS Recording Search. When you 
restart BS Recording Search the saved folder will be used as the initial folder in 
the folder dialog window. 
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6.2 Main Search options 
 
You can choose one of the following 4 options 

6.2.1 ModeS Option 
 
If you want to extract all records associated with a particular ModeS (hex code) 
select the ModeS (Hex Code) option button. 
 
An input text box will appear. Enter the required ModeS hex code. e.g. 400ABC. 
The ModeS code must be 6 characters – wild card characters are not  permitted. 
 
The  “SpeedUp Playback” options will appear. See section 6.3 below.  
 
 

 
 

6.2.2 Callsign Option 
 
If you want to extract all records associated with a particular flight callsign e.g. 
BAW123 select the Callsign option button. 
 
An input text box will appear. Enter the required callsign. The following formats 
and wild card characters are permitted :- 
 
 

 
 

·  BAW123 – in this case there are no wild cards entered and records that 
exactly  match the input callsign will be extracted from the file. 

 
 

 

 
 

·  BAW12% - in this case all records where the callsign starts  with BAW12 
will be extracted e.g. BAW123, BAW126, BAW120A etc. 
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·  %AW123 – in this case all records where the callsign ends  with AW123 
will be extracted e.g. BAW123, AW123, ZAW123, ABCAW123 etc 

 
 
It has been assumed that in most circumstances the start or end of a callsign will 
be known. Using the wild card characters at the start and end of the callsign is 
not permitted.  
 
The  “SpeedUp Playback” options will appear. See section 6.3 below.  
 

6.2.3 Part File Option 
 
If you want to extract all records out the recording file that fall between two times 
select the Part of the File option button. 
 
 

 
 
 
The start and end times will default to the current date and time. 
 
Select each element of the start date and time and modify to show the start date 
and time required. 
The date and time is displayed in the same format as the default Basestation 
Recording Files e.g. year (yyyy), month (MM 01-12), day of month (nn 01-31), 
hour (in 24 hour format 00-23) and minute (nn 00-59) . 
 
Once the start date and time has been entered, select the required end date and 
time. This will have already been modified to be the same as the selected start  
date and time, so normally you will only need to change the time values. 
 
The range selected will include everything equal to or greater than the start date 
and time, and everything LESS than the end date and time e.g. so a time range 
of 12:34 to 12:57 will extract all those records between 12:34:00.000 and 
12:56:59.999 
  
The  “SpeedUp Playback” options will appear. See section 6.3 below.  
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6.2.4 Whole File Option 
 
If you want to speedup a whole file select the Whole File option button. 
ALL  the records in the input recording will be processed and added to the output 
file. 
 
The  “SpeedUp Playback” options will appear. See section 6.3 below.  
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6.3 SpeedUp Facility 
 

6.3.1 SpeedUp Overview 
 
Because the standard Basestation Play Previous Recording facility does not 
provide a method of fast play, this speedup facility attempts to perform a similar 
function. 

 
Every record that is saved in a recording file has a date and time. By modifying 
the time, this program apparently speeds up the output, so when the file is played 
back it appears at 2 times, 5 times or 10 times the original speed. 
 
As an example if a particular flight/callsign is recorded in real time for 20 minutes 
from 12:34 to 12:54, speeding up the output using two times the speed will have 
the effect of replaying the recording in 10 minutes instead of 20 minutes. A ten 
times increase will replay the recording in 2 minutes. 
 
See Section 9 Playback  below for more information regarding playing back files 
generated by BS Recording Search. 
 

6.3.2 SpeedUp Options 
 
If you want use the speed up option select the Speed Up Playback check box. 
 

 
 
Then select one of the 3 options 
 

·  2x – will speed up the output at twice the real speed. 
 

·  5x - will speed up the output at five times the real speed 
 

·  10x - will speed up the output at ten times the real speed 
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6.4 Dummy Records 
 
When playing back a recording file using the standard Basestation Play Previous 
Recording menu item data, as soon at it gets to the last record in the file, 
Basestation immediately clears the ‘radar’ screen. I have found that I would 
prefer if the ‘radar’ screen effectively froze the displayed data for a period of time. 
 
To allow for this the output file generated by BS Recording Search can contain 
12 dummy lines at the bottom of the new output file. This enables the radar 
screen to appear frozen for 1 minute before Basestation clears the ‘radar’ screen. 
 

 
 
If you require these dummy lines select the check box. 
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7 Output file name 
 
To ensure that input file is not modified, a new output recording (.bst) file is 
created and placed in the Output Folder selected above. Although these output 
file names tend to be rather long, they are informative and provide a good 
indication of what is contained in the file. Once the file has been generated, you 
can rename it to suit your own requirements. 
 
 
If you selected the Modes option the output file will be named 
ModeS_<modes>_<speedup value>_<input file name> 
e.g. ModeS_400ABC_2x_20080122-153551.bst 
 
 
If you selected the Callsign option the output file will be named 
Callsign_<callsign>_<speedup value>_<input file name> 
e.g. Callsign_BAW123_2x_20080122-153551.bst The wild card character will not 
be included in the output filename. 
 
 
If you selected the Part of the File option the output file will be named 
PartFile_<starttime>-<endtime>_<speedup value>_<input file name> 
e.g. PartFile_1234-1254_2x_20080122-153551.bst 
 
 
If you selected the Whole File option the output file will be named 
WholeFile_<speedup value>_<input file name> 
e.g. WholeFile_2x_20080122-153551.bst 



BS Recording Search 
 

________________________________________________________________ 
Version 0.2 Page 15 of 31 March 4th 2008 

 

8 Performing the Search 
 

8.1 Search 
 
When all the input options and data have been entered, start the search process 
by executing the Search command. A series of validations are performed to 
ensure that all the selected options / data are valid. Appropriate warning 
messages or error messages are displayed as necessary. 
 
When the main search process starts, all the input fields are disabled (greyed 
out) and a progress bar will be displayed above the Search command. 
 
At the end of the search process a message will appear with the output file 
name, the number of records searched, and the number of records added into 
the output file. 
 

8.2 Stop Search 
 
Once the Search has started, the progress bar will give an indication of how 
much of the search has been performed. 
During this time the Search  command is changed to a Stop Search command. If 
you execute the Stop Search command during this period the current search will 
be terminated. 
 
If you stop the search after  some records have been extracted from the input file, 
the extracted sub-set of records are saved in the output file. 
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9 Playback 
 
Once the output file has been generated it can be played back using the 
standard Basestation Play Previous Recording facility selected from the 
Basestation File menu. 
 
This section explains some of the features of playing back files generated by BS 
Recording Search. 
 

9.1 Displayed Time of SpeedUp Files 
 
If a particular aircraft is recorded in real time for 20 minutes from 08:30 to 08:50 
and then played back in real time (no speed up), the time in the top right corner 
of the Basestation window will 
 

start at     and end at    
 
 
If a new file is created with a speed up value of 10, the file will be replayed in 2 
minutes. In this case the Basestation window will 
 

start at     and end at     
 
 
When playing back a ‘speeded up’ file, the time sho wn in the top right of 
the Basestation window will NOT reflect the origina l time of the recording. 
 

9.2 Basestation Settings 
 
When you play back a recording, all your Basestation configuration settings will 
still be effective e.g. if you are using a view that you have limited only to show 
aircraft between 0 and 10,000 feet, then that setting will apply to the displayed 
aircraft in the playback recording. 
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9.3 Trail Lengths 
 
One of the display options in Basestation is the ability to show trails of the 
aircraft. This is set in the Basestation Settings menu – Display Settings - Aircraft 
Display screen. For this explanation let’s assume it is set to 60 seconds. 
 
If a particular aircraft is recorded in real time for 20 minutes from 08:30 to 08:50 
as it traverses the Basestation radar screen from one side to the other, the 60 
second (1 minute) trail length will appear as one twentieth of the width of the 
screen as shown below 
 

 
 
 
 
If a new file is created with a speed up value of 10, the file will be replayed in 2 
minutes. The Basestation trail setting is still set to 60 seconds, but now 60 
seconds represents half the total time that the aircraft will be displayed. In this 
case the trail will look as shown below 
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To display a trail in the same proportion that you normally see, you must reduce 
the trail setting by the speed up factor. In the case of a 10 times speed up file, 
you should reduce the trail setting to 6 seconds (60 seconds divided by 10). Then 
when the speeded up file is played back the trails will appear their ‘normal’ length 
as shown below. 
 

 
 
Since the trail setting is a basic Basestation function, it is not possible for this 
program to automatically reconfigure the setting. 
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9.4 Existing Basestation Playback Peculiarities 
 
In my opinion, the playback facility in Basestation has not received the attention 
that many would have liked. I have found the following peculiarities which are 
part of the basic Basestation functionality and as far as I know they are nothing to 
do with the revised files that this application generates. 
 
These are my interpretation of the Basestation playback peculiarities. 
 

9.4.1 Playback Commands 
 
When you use the Play Previous Recording  menu, the “Stop 
Recording/Playback” and the “Pause Recording” menu items become active – 
they are not greyed out. The “Pause Recording” doesn’t do anything.  
 

9.4.2 Recorded Data (Squawks) 
 
Even though they are in the recording file, when played back the squawk codes 
are not displayed in the aircraft list nor on the radar screen. 
 

9.4.3 Playback while SBS-1 Connected 
 
If you are displaying live data from the SBS-1, and you then execute the Play 
Previous Recording  menu, there may be a slight delay before the recorded data 
is displayed. My understanding is that Basestation writes all the current aircraft 
being received to the database in a similar way to what it performs when you 
shutdown Basestation. Likewise when the file being played back reaches the 
end, or you use the Stop Recording/Playback  menu option, Basestation starts 
monitoring the live data being received from the SBS-1 and again starts writing 
data to the database.. 
 

9.4.4 Playback and Restart 
 
When you execute the Play Previous Recording  menu, the aircraft in the 
selected file will be displayed.  
 

·  If before the end of the recording you execute the Stop 
Recording/Playback , the playback stops. If you then play the same 
recording again, it will start from the point where it had been previously 
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stopped – so instead of stopping and restarting a playback, it effectively 
pauses the playback. 

 
·  To compound the problem if you let the playback recording finish as 

normal, and then play the same recording again, it will start from the point 
where it had been previously stopped – the end. So it starts the playback 
at the end, finds there is nothing else to playback, so stops. It appears to 
do nothing. 

 

9.4.5 Playback displays other aircraft 
 
I have had reports that when using the playback facility with Basestation 
connected to the SBS-1, there are occasions where an aircraft not in the 
recording file is displayed. I’ve not seen this myself but I am fairly certain that the 
files generated by BS Recording Search are accurate and that these must be 
some interaction within Basestation. If you see this and have the opportunity, 
shutdown Basestation, disconnect SBS-1, start up Basestation and then play the 
recording again and see if you get the same extra aircraft being displayed. 
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10 Other bits and pieces 
 

10.1 Moving the BS Recording Search Window 
 
The BS Recording Search window is initially positioned in the top left corner of 
the screen. It can be moved to any other location on the screen by the normal 
method of dragging the top bar of the window. The new location is saved when 
you exit BS Recording Search and will be used when you restart BS Recording 
Search. 
 

10.2 Re-sizing the Window 
 
There may be circumstances where the input file name is wider than the default 
window width. It is possible to drag the right hand edge of the window to the right 
to enlarge the window. This new setting is saved when you exit BS Recording 
Search and will be used when you restart BS Recording Search. 
 
It is not possible to change the height of the window. 
It is not possible to reduce the width of the window to less than the default width. 
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11 Detailed Installation Guide 
 
In these instructions I have attempted to explain the installation process in a bit 
more detail. 
 
All the following is based on Microsoft XP Home Edition , although the flexibility 
provided to the user to configure some of the core programs e.g. Windows 
Explorer, it is highly likely that your screens may not match exactly those shown 
here. 
 
[if anyone could produce an equivalent set of instructions for Vista please let me know} 
 
I have used Windows Explorer for demonstration purposes. The ‘vn.n’ in the file 
name represents the current version number of BS Recording Search.  

11.1 Download 
 
Go to the download web site. Click on “BS_Recording_Search_vn.n.zip ”. 
 
You should be presented with the option of downloading the file. 
Select the download and when the ‘Save As’ window appears navigate to where 
you want the zip file saved on your PC. In the screen shots below I have saved 
the zip into C:\Documents and Settings\user_name\My Documents\temp. 
 
 

 
 
If your display shows an icon instead of all the file details you can reconfigure 
your Windows Explorer by going to the View Menu and clicking on the ‘Details’ 
option. 
 
If your file only shows as “BS_Recording_Search_vn.n” (without the ‘.zip’ suffix) 
you can reconfigure your Windows Explorer by going to the Tools Menu > Folder 
Options > View and then untick the checkbox next to “Hide extensions for known 
file types”. Click OK. 
You should now see the “.zip” suffix. 
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11.2 Extract Zip File 
 
When you right click on the BS_Recording_Search_vn.n.zip” file there may be 
different options that appear :- 
 

11.2.1 Extract Command – Option 1 
 
Right click on the BS_Recording_Search_vn.n.zip” file and select 

Open with > 
 Compressed (zipped) Folders 

 

11.2.2 Extract Command – Option 2 
 
Right click on the BS_Recording_Search_vn.n.zip” file and another window will 
appear. Use the 

Extract all 
 

11.3 Extraction Wizard 
 
The Extraction Wizard should start similar to that shown below. 
 

 
 
Click “Next” 
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Remove the text “BS_Recording_Search_vn.n” from the directory name and 
replace with BSRS so it looks like this 
 
 

 
 
Click Next and the extraction process will start. 
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When file extraction is complete the following screen will appear 
 

 
 
Untick the Show extracted files checkbox. 
Click Finish. 
 

11.4 Installation Files 
 
In Windows Explorer you should now have a display similar to this 
 

 
 
Double click on BSRS and you should have a display similar to 
 

 
 
Copy the user guide to a suitable folder on your PC. 
 
You are now ready to install the application. 
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11.5 Microsoft .NET Framework 3.5 
 
The BS Recording Search application requires an environment called Microsoft 
.Net Framework 3.5. To check whether you already have it installed go to the 
Control Panel (Start | Control Panel) and double click on “Add or Remove 
Programs” 
 
Scroll down and you should see something similar to this - 
 
 

 
 
 
If you see Microsoft .NET Framework 3.5 then it is already installed. Continue 
with Section 11.4 Install Application. 
 
If you haven’t got .NET 3.5 installed, there are two options. 
 

11.5.1 Install as part of the BS Recording Search i nstall 
 
Refer to Section 11.6 and .NET 3.5 should install as part of the main BS 
Recording Search installation process. 
 

11.5.2 Install .NET Framework First 
 
You can install the .NET Framework environment before attempting to install BS 
Recording Search. See Section 12 Installing Microsoft .NET Framework 3.5 
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11.6 Install the BS Recording Search Application 
 
Return to the BSRS folder 
 

 
 
Double click on setup.exe and the installation will begin. If you are installing 
Microsoft Framework 3.5 as part of this installation, you may see additional 
screens similar to those shown in Section 12 Installing Microsoft .NET 
Framework 3.5. 
 
The following screen may briefly appear. 
 

 
 
 

 
 
Click on Install 
 
The following screens may briefly appear. 
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When completed the BS Recording Search window should appear in the top left 
hand corner of your screen. 
 
 

 
 
Congratulations - the application is now installed. 
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12 Installing Microsoft .NET Framework 3.5 
 
Return to the Kinetic forum page regarding BS Recording Search where there 
are 2 options available 
 

·  Install a bootstrap program and then install .NET Framework 
 

·  Download a complete executable 
 
The bootstrap option initially downloads a small ‘bootstrap’ program which you 
run. This will determine what further information is required and then connect to 
the Microsoft site to download and install .NET Framework 3.5. 
 
I have had reports that the bootstrap version can be intermittent. If you have 
problems try the complete executable. 
 
The other option is to download the complete package in one go – it is about 
200Mb. When you execute this, it has all the information it needs and doesn’t 
connect to the Microsoft site. 
 
During the installation of Microsoft .NET Framework you my see screens similar 
to these. 
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Microsoft .NET Framework 3.5 is now installed. 
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13 Document History 
 
Version Date Changes 
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